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Introduction
As wireless telecommunication features continue to expand into virtually every
control and sensor technology in military, industrial, and domestic environments, a
wide array of new wireless transmitters and transmitter components will need to be
designed, prototyped, calibrated, and analyzed for quality assurance. There are many
measurement methods and figures of merit that can be brought to bear in analyzing
transmitter performance. Two such methods, occupied bandwidth (OBW) and channel
power measurements, are relatively easy measurements to make that can reveal
distortion, poor power amplifier (PA) design, filter effects, system noise, and other
signal degradation factors.
Recently, with the advent of real-time spectrum analyzers (RTSAs), pulsed, frequency-hopping,
and other transient/intermittent signals can now be characterized using OBW and channel power
measurements. Signal Hound’s Spike™ software and one of the Signal Hound RTSAs, such as a
BB60C, can be used to analyze highly modulated signals and transient signals using built-in
occupied bandwidth and channel power measurement features.
This document will walk through an example setup and testing procedure for both occupied
bandwidth and channel power measurements. The goal of the walkthrough is to demonstrate and
explain the critical aspects of occupied bandwidth and channel power measurements and how Signal
Hound tools can be used to reliably produce low-cost and low-learning-curve measurements rapidly
and with little setup.

Occupied Bandwidth and Channel Power Measurements
with a Real-time Spectrum Analyzer
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Overview of Occupied Bandwidth Measurements
For any frequency or phase modulated signal, occupied bandwidth measurements are critical in ensuring that the transmission hardware
and modulation parameters are properly designed to prevent interference and efficient transmission. For example, cellular technologies,
Wi-Fi, and many more recent digital modulated technologies use a variety of modulation parameters, and some are even reprogrammable.
Hence, ensuring that the occupied bandwidth of the modulated transmissions stay within a specified bandwidth under all modulation
configurations can help a designer make the necessary tradeoffs between hardware costs and data rate and bit-error-rate (BER).
As pulsed radar signals and transient modulation signals are nearly impossible to catch with standard spectrum analyzers, RTSAs enable
capture and record of real-time signals, and can be used to illuminate important signal characteristics necessary in identifying and analyzing
pulsed hardware and modulation schemes. OBW is one such measurement, where wide-bandwidth real-time signal capture of an entire
pulsed signal and its transient behavior is necessary to make an accurate analysis of the transmitter and modulations signal characteristics
(see Figure 1).
There are several methods of measuring OBW. However, the general structure of the measurement concludes that OBW is the bandwidth
of a signal in which 99% of the total integrated power of the transmitted spectrum is contained. Some standards also include specific
settings for an analyzer to properly take an occupied bandwidth measurement. For example, the 3GPP dictates that the measurement of
the distribution of the power spectrum is made using a Gaussian filter with a bandwidth greater than 10 MHz and a resolution bandwidth
filter (RBW) set to 30 kHz or less for WCDMA modulation.
The order of operations for the measurement is that first the total spectral power in the frequency range is measured. Following this
calculation and beginning at the lowest frequency range in the sweep, the power distribution at each frequency is summed until the
summation reaches exactly 0.5% of the total spectral power within the sweep range. This measurement is repeated inversely starting
at the highest frequency range and summing the power at each frequency until the sum reaches 0.5% of the total power. This
method reveals the upper and lower frequency boundaries of the occupied bandwidth at the 0.5% points.

Figure 1—Some spectrum analyzer software packages are able to automatically measure occupied bandwidth,
saving the effort of exporting trace data and analyzing it in 3rd party data analysis suites.
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Overview of Channel Power Measurements
From Wi-Fi, Bluetooth, and cellular to broadcast radio stations and satellite TV, much of the usable RF/microwave spectrum is segmented
into designated channels. However, there is very limited spectrum and most countries limit certain applications to a small range of
frequencies. Thus, many telecommunications protocols depend upon tightly packed channels that further subdivide the spectrum
in hopes of preventing interference and optimizing use of the available spectrum.
As not all radio hardware is created equal, some modulation schemes may be more prone to nonlinear distortions and phase noise
related spectral regrowth; interference from adjacent channels can dramatically reduce communications capability. Measuring
the power within a channel, and how much power is also transmitted into adjacent channels, can prevent transmitter designs and
operation that lead to interference.

Channel Power
Measuring the amount of power transmitted within the designed
channel is necessary in the adjacent channel power ratio (ACPR) or
adjacent channel leakage ratio (ACLR) measurements. Additionally,
measuring the channel power can give insight into the efficiency of
the transmission system and the modulation scheme chosen.
Channel power is calculated with a digital spectrum analyzer by
integrating the FFT bins over the programmed channel bandwidth
using the following equation:

Adjacent Channel Power (ACP) or Adjacent
Channel Leakage (ACL)
Another measurement of interest is the adjacent channel power
(ACP), which is the measured power in the adjacent channels to the
channel of interest. This measurement is performed as the channel
power measurement is performed in the adjacent channels.

Adjacent Channel Power Ratio (ACPR) or
Adjacent Channel Leakage Ratio (ACLR)
The comparison of the amount of power in the primary channel to
the amount of power in the adjacent channels is often used as a
transmitter and modulation scheme figure of merit of the linearity
and noise performance. ACPR is the logarithmic comparison of the
channel power in the primary channel compared to the adjacent
channel power.

The window bandwidth is equivalent to the noise bandwidth of the
RBW filter setting used, and the Pch result is in milliwatts if the FFT
bin data is provided in dBm. Specifically, in Spike, the average
detector and power video units must be selected with the spur
reject algorithm checked as disabled. These settings are necessary
to achieve an accurate measurement for channel power, as the
calculation requires a sample detector or root-mean square
(RMS) power averaging detector to be used.

The ACPR measurement is best suited to revealing the significance
of the nonlinear characteristics of the power amplifier, amplifier
subassembly components/connections, and the mixer components.
The impacts of phase noise and the systems noise behavior
also contribute to the ACPR performance of the system.
Fortunately, Spike paired with a Signal Hound RTSA enables easy
measurement of channel power, adjacent channel power, and ACPR.
Additionally, Spike is capable of measuring the channel power
characteristics for more than just the immediately adjacent
channel, and can be configured to measure secondary
and tertiary adjacent channels.

Figure 2—Channel power of an FM broadcast band
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Equipment and Accessories for ACPR and OBW Measurements
Prior to more flexibly programmed spectrum analyzers and RTSAs, ACPR and OBW were performed by specialized or custom test sets.
Typically, all that is necessary for this measurement is a spectrum analyzer and software with OBW and ACPR measurement modes,
the device-under-test (DUT), and the accessory interconnect, cabling, PC, and power supplies. If the spectrum analyzer software is not
capable of OBW and ACPR measurements, the trace data can be exported and analyzed using a 3rd party software suite capable of
mathematical analysis of array data.
Signal Hound has enabled ACPR and OBW measurements in a very cost-effective, efficient, and small footprint implementation with
their series of RTSAs and Spike. For convenience and easy demonstration, this guide uses the Signal Hound BB60C for the
spectrum analyzer and the Signal Hound VSG25A to emulate a DUT.

Test Equipment Suggested for ACPR and OBW Measurements:
Signal Hound BB60C
The 27 MHz of instantaneous bandwidth provided by the BB60C enables real-time OBW and ACPR
measurements of very wide-bandwidth signals, transient or continuous. However, if a frequency or phase
modulated continuous wave signal is the desired measurement target, a swept-spectrum analyzer can be
used to similar effect. This walkthrough will use the BB60C RTSA.			
Signal Hound BB60C Accessories
		
USB 3.0 Double Power Cable – Provided by Signal Hound with every BB60C. These cables need to be
		
connected to a USB 3.0 compatible PC. Only a USB 3.0 compatible PC can adequately supply the
		
necessary power through the USB cables and carry the digitized frequency data from the RTSA.

➔

➔ SMA to BNC Adapter – Used for convenient connection to BNC interconnect transmission lines.
Spike Spectrum Analyzer Software (from Signal Hound)
Spike requires a PC equipped with Windows 7, 8, or 10 operating system either 32 or 64-bit.
For Signal Hound’s BB-series RTSAs, an Intel Desktop quad-core i5/i7 processor model number 3000 series
or later is required. Additionally, a minimum of 4 GB of RAM are required, with 8 GB of RAM being the
recommended hardware. Spike typically requires less than 1 GB of available hard disk space.
Download for free at https://signalhound.com/spike.
Signal Hound VSG25A
A 100 MHz to 2.5 GHz vector signal generator from Signal Hound.

➔ USB 2.0 Male A to Male B-type – This cable is used to connect the Signal Hound VSG25A to the

		

PC via a USB 2.0 port.

➔ SMA to BNC Adapter – Used for convenient connection of the VSG25A to the BB60C.
➔ Signal Hound VSG25A Control Software – This software is used to program the VSG25A and is

		
		

available for free on the Signal Hound website.
http://www.signalhound.com/sigdownloads/VSG25/VSG25_104.zip

Equipment & Accessories

➔ BNC-BNC Cable – This coaxial cable is used to connect the VSG25A to the BB60C during the

		

OBW and ACPR measurements.

➔ PC with 2x USB 3.0 and 1x USB 2.0 Ports and Necessary Specs – This PC is used to control the

		

VSG25A and to run Spike and BB60C data.
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Equipment Setup and Configuration for the OBW and ACPR Walkthroughs
These walkthroughs leverage the Signal Hound BB60C, VSG25A, Spike, and VSG25A Software to demonstrate an occupied bandwidth
measurement. The VSG25A is used as the DUT in the measurement as it is a signal generator capable of complex vector modulation,
including frequency modulation.
The connection diagram below describes the appropriate connection and connection types for each component of the OBW and
ACPR measurements. Hand tightening of the SMA to BNC coaxial connectors should be adequate for the SMA ports on the VSG25A
and the BB60C. Conversely, an SMA to SMA cable can be used to directly connect the VSG25A and BB60C.
Note—Test ports will degrade with performance over time and have a finite number of mating cycles before failure. Hence, an intermediate adapter is used to prevent
early test port degradation and failure.

As the VSG25A and the BB60C are both powered by the USB ports of the PC, it is suggested to run the devices on the PC USB ports capable
of supplying adequate power to both devices. If two separate USB 3.0 connections are used for the BB60C’s dual USB cable and a USB 2.0
connection is used for the VSG25A, this arrangement should be adequate.
Note—All appropriate protective gear, grounding mats/straps, and a clean environment should be used when operating any electrical measurements.

Setting Up the BB60C with Spike
Test equipment setup of the BB60C
1.

Ensure the test environment or operator is properly
grounded and clean

2.

Connect the SMA to BNC adapter to the RF SMA port on
the BB60C

3.

Connect the BNC cable to the SMA to BNC adapter

4.

Connect both USB male connectors to the PC USB 3.0
female connections

5.

Insert the USB cable into the USB 3.0 port of the BB60C

6.

Observe the green ‘Ready’ light before proceeding

7.

Connect the BB60C with Spike
a.

Ensure that Spike is properly installed

b. Ensure that the USB drivers are properly configured
c.

Launch Spike

d. Connect the BB60C with Spike by clicking
File > Connect > BB60C

Once the BB60C is connected to the PC with the dual USB 3.0
cable (see Figure 3) and the appropriate drivers and Spike are
installed, a green ‘Ready’ light should appear. This ‘Ready’ light
should turn orange rapidly after booting up Spike and
connecting the BB60C, as the default measurement
parameters are engaged and measurement begins.

Figure 3—The VSG25A, BB60C, and PC connection order.
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Setting Up The VSG25A
After proper installation of the VSG25A control software, the following steps connect the VSG25A to the computer.
Test equipment setup of the VSG25A
1.

Ensure the test environment or operator is properly grounded and clean

2.

Connect the SMA to BNC adapter to the RF SMA port on the VSG25A

3.

Connect the BNC cable to the SMA to BNC adapter (the other end should already be attached to the BB60C)

4.

Connect the USB male connector to the PC USB 2.0 female connection

5.

Insert the USB cable into the VSG25A’s USB 2.0 port

6.

Observe the green ‘Ready’ light before proceeding

7.

Connect the VSG25A with the VSG25A software
a.

Ensure that the VSG25A software is properly installed

b. Ensure that the USB drivers are properly installed
c.

Launch the VSG25A software

Figure 4—An Example setup for OBW and ACPR measurements using the
Signal Hound BB60C, VSG25A, and Spike with an intel i7 PC.
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Occupied Bandwidth Measurement Walkthrough
The following procedures work through the process of using Signal Hound equipment for occupied bandwidth measurements.

Occupied Bandwidth Sinusoidal Frequency Modulated Signal Test Procedure
This section of the walkthrough will detail the programming parameters and steps of properly measuring the occupied bandwidth
of a 97.9 MHz carrier frequency modulated with a 20 kHz sine wave with an FM deviation of 25 kHz at -30 dBm. The VSG25A is used
as the DUT in the measurement performed by the BB60C RTSA and recorded and controlled by Spike.

1. Setup the BB60C and Spike for OBW Measurement
The following steps detail the exact parameter definitions to be input in Spike. These parameters can be manipulated as the BB60C is taking
measurements. However, if the VSG25A and BB60C are appropriately connected, the only signal in the measurements before activating the
VSG25A should be the noise floor, and possibly, low-level spurs.
Configuring sweep settings in Spike for OBW measurement

1.

From the main menu, select Analysis Mode > Sweep

2.

In the Frequency panel, set the following:
a.

6.

a.

c.

In the Amplitude panel, set the following:
a.

e. Select Update

Ref Level = -30 dB

In the Bandwidth panel, set the following:
a.

RBW Shape = Flat Top, Nutall, or Gaussian

Avg Count = 10

d. Color = yellow

b. Div = 10 dB
4.

Trace = One

b. Type = Clear & Write

Center Frequency = 97.5 MHz

b. Span = 1 Mhz
3.

In the Traces panel, set the following:

f.

Deselect Hide

7.

In the Offsets panel, in the Ref Offset field, type 0.000.

8.

In the Occupied Bandwidth panel, set the following:

b. RBW = 616.455078 Hz

a.

c.

b. % Power = 99.000

VBW = RBW

Select Enabled

d. Select Auto RBW
e. Select Auto VBW
5.

In the Acquisition panel, set the following:
a.

Video Units = Power

b. Detector = Average
c.

Swp Time = 1.000 ms

Figure 5—Signal Hound’s Spike can be configured to measure
occupied bandwidth with the click of an enable option.
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2. Setup VSG25A for the measurement

3. Analyzing the Measurement

When launching the VSG25A software, a dialog with all of the
programmable parameters of the VSG25A will open. The image and
configuration parameter listing below provides the description of
how to generate a sinusoidal frequency modulated signal at 97.5
MHz with a modulation rate of 20 kHz and FM deviation of 25 kHz
at -30 dBm power level.

After applying the RF On setting, a single tone should appear
at 97.5 MHz. Once the Mod setting is On, then the sinusoidal
frequency modulation should become apparent as several tones
appear symmetric around 97.5 MHz. The diagram below indicates
observable areas of interest. A marker is used to show that the peak
frequency of the signal is at the desired 97.5 MHz. The marker
settings on the left-hand side of Spike panel can be used to adjust
the marker parameters and create new markers. To place a marker
on the peak frequency, simply click “Peak Search” in the Markers
selection field.

Configuring The VSG25A for OBW Measurement
1.

Select the FM button in the panel on the right-hand side
of the window

2.

In the fields near the top of the window, set the following:
a.

.

Frequency (MHz) = 97.5

b. Amplitude (dBm) = -30
3.

In the Frequency Modulation panel, set the following:
a.

Modulation Rate (kHz) = 20

b. FM Deviation (kHz) = 25
c.
4.

Modulation Shape = Sine Wave

Click Apply Settings
Note—This must be done before proceeding to the next steps.

5.

In the RF pane, select On

6.

In the Mod pane, select On

Figure 7—Areas of interest in the measurement

The modulated signal should be located at roughly 97.5 MHz with
a power level within several dBm of -30 dBm. However, the signal
should have less than -30 dBm of power at the peak frequency as
some signal power is spread over the modulated signal range.
The occupied bandwidth feature should create upper and lower
frequency markers designating the boundaries within which 99%
of the power is contained. There is an OBW display window on the
bottom left of the measurement window, which indicates the OBW
measurement and the total power of the signal. The total signal
power should be within a few fractions of a dBm of -30 dBm.
It should be observed that the occupied bandwidth of the signal
is much greater than the modulation depth and the FM deviation
settings of the transmitter. This effect occurs as a result of the
resultant tones of the pure sinusoidal modulation, as well as the
imperfect linearity, noise, and phase noise characteristics of the
transmitter.
Figure 6—Configuring the VSG25A for FM modulation.
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Occupied Bandwidth Measurement for Pulsed or Intermittent Signals
Unlike with continuous wave signals, pulsed signals and transient signals may not necessarily have consistent characteristics in time of
frequency. In the case of some signals, such as pulsed radar, these signals may demonstrate consistently repeating pulsed square wave
signals with set repetition rate, constant pulse width, constant shape, and amplitude. In this case, it is easy enough to trigger on this
signal and accurately measure its characteristics, including occupied bandwidth.
However, for pulsed or transient signals that may be intermittent or have unknown characteristics, taking these measurements may be
a greater challenge. Fortunately, a real-time spectrum analyzer is able to observe and measure this transient behavior down to the attack
time limits of the analyzer. Several tools exist to help identify and measure intermittent time-varying signals, such as a waterfall
spectrum display (spectrogram), persistent display, max-hold, zero span mode, etc.
The following walkthrough will demonstrate using the max-hold and trace-data export features to provide detailed analysis, including
occupied bandwidth, for pulsed and other transient signals. The export of trace data is necessary, as Spike occupied bandwidth
measurement feature will currently only measure the incoming data instantaneously.

1. Setup BB60C and Spike for the Pulsed
OBW Measurement
As this measurement also uses the VSG25A and the same
frequencies are used as in the continuous wave OBW measurement,
the configuration of the BB60C and Spike is the same as the
previous measurement. See 1. Setup BB60C and Spike for
OBW Measurement for details.

2. Setup VSG25A for the Pulsed OBW Measurement
This measurement will use the VSG25A to generate a square pulse
wave with consistent frequency and timing characteristics at 97.5
MHz with a pulse width of 100ms and a pulse period of 1000ms at
-30 dBm power level.

3.

In the Pulse Modulation panel, set the following:
a.

Pulse Width (ms) = 100

b. Pulse Period (ms) = 1000 (the equivalent of 1 second)
4.

Click Apply Settings
Note—This must be done before proceeding to the next steps.

5.

In the RF pane, select On

6.

In the Mod pane, select On

Now you can use 2D spectrogram mode within Spike to monitor and
confirm the appropriate signal characteristics over time, bandwidth,
and amplitude.

Configuring The VSG25A for Pulsed OBW Measurement
1.

Select the Pulse button in the panel on the right-hand side
of the window

2.

In the fields near the top of the window, set the following:
a.

Frequency (MHz) = 97.5

b. Amplitude (dBm) = -30

Figure 8—The VSG25A configured for a pulsed OBW measurement.
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7. In the upper left-hand corner of the Spike interface, from the
Spectrogram menu, select 2D Spectrogram
Spike now displays the RF activity in the spectrum waterfall plot
(see Figure 9).

3.

Click the color swatch in the Color field. The Select Color
window appears

4.

In the Select Color window, either click on a color chip or use
the available fields to configure your trace color, and click Ok

5.

Select Update

As the signal is apparently pulsed at an even pulsing ratio, a
method of catching the highest power at each frequency of
interest is to use the Max-Hold trace mode instead of the
Clear and Write trace mode.

Figure 10—The Max-Hold trace in red and Clear and Write trace in yellow
demonstrate that the Max-Hold trace is able to reveal the highest power
levels at each individual frequency and hold those values for comparison.
Figure 9—A 2D Spectrogram reveals the intensity of power levels within the
sweep range. However, a real-time spectrum analyzer is capable of capturing
even extremely short duration signals as long as they are contained within
the instantaneous bandwidth of the analyzer.

Using Max-Hold Trace Mode with Spike
The Max-Hold feature of Spike uses the highest power level yet
measured in each frequency bin and displays that as a trace. This
approach reveals the highest power at each frequency over the length
of observation. Spike enables multiple traces to be viewable in the
same display. If a second trace is configured to have the Max-Hold
property, then both a Clear and Write and Max-Hold trace can be
displayed for comparison.

Export and Analyze Trace Data
As Spike is unable to perform an occupied bandwidth measurement
on anything but instantaneous data from the BB60C, external tools will
be necessary to calculate the OBW. This can be done by exporting the
trace data and further analyzing the data in 3rd party software. The
export function will export a CSV file (.csv) that can be read by other
software and can be further analyzed.
Exporting the Max-Hold Trace Data from Spike
While Spike is displaying pulsed data from the VSG25A,
do the following:

Creating a Second Trace with Max-Hold Mode

1.

In the Traces panel, from the Type drop-down menu,
select Max Hold

While Spike is displaying pulsed data from the VSG25A,
do the following:

2.

Near the bottom of the Traces panel, click Export

3.

Save the CSV file in an appropriate location to be accessed
by the 3rd party software

1.

In the Traces panel, from the Trace drop-down menu,
select Two

2.

From the Type drop-down menu, select Max Hold

The CSV is now ready for analysis by any of the software tools
available on the market for analyzing array data from CSV files.
Examples include MATLABTM, LABVIEWTM, MicrosoftTM Excel,
and many others.
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Channel Power and Adjacent Channel Power Ratio Walkthrough
This section of the walkthrough will demonstrate the use of Spike built-in channel power, adjacent channel power, and adjacent channel
power ratio measurement features. The first two sections of this walkthrough use the VSG25A as the signal generating DUT.

Channel Power Measurement Procedure

Configuring Spike for channel power measurements

The following procedure works through the process of using
Signal Hound equipment for channel power measurements.

While Spike is displalying data from your test setup:

1. Setup the BB60C, VSG25A, and Spike
for a Channel Power Measurement
Using the same settings specified in the Occupied Bandwidth
Measurement Walkthrough for the VSG25A, BB60C, and Spike
prepares the equipment for the walkthrough. This time, however,
the only difference is that the Channel Power Settings are
configured instead of manipulating the Occupied
Bandwidth parameters.

2. Configure the Channel Power Settings
As with the OBW measurement, Spike provides a convenient
measurement field. In the same field as OBW, Channel Power
measurement can also be configured and programmed to
automatically perform channel power and adjacent channel
power ratio measurements. It is important to note that the
center frequency of the primary channel should be the center
frequency of the frequency sweep programmed in the Frequency
fields. The Channel Power measurements assume that the
center frequency desired in the sweep center frequency.

1.

In Spike, in the Channel Power panel, set the following:
a.

Width = 200 kHz

b. Spacing = 200 kHz
c.
2.

Count = 1

Select Enabled

3. Observe the Channel Power Measurement
The results of the Channel Power measurement are a number in
dBm below, and in the center, of the channel of interest. A grey
shaded area is placed on the frequency display, which indicates
the channel being measured (see Figure 11).

Figure 11—The Channel Power measurement reveals the total power within
a programed channel. If a signal has highly linear and low noise/phase noise
characteristics, the majority of the transmitted signal power should be contained within the primary channel.

The Width field sets the bandwidth of the channel to be
measured. The Spacing field dictates the center-frequency to
center-frequency spacing of the channels. For example, to measure
a channelized modulation protocol with guard bands, the Width
can be set to the maximum channel bandwidth minus the
sum of the guard band bandwidths.

15 // Further Reading

Adjacent Channel Power Ratio Measurement
Where the channel power measures the total power within a
channel, adding additional “counts” or channels in the Channel
Power field in Spike, will automatically measure the power in
the adjacent channels and provide a ratio of the adjacent channel
power to the primary channel.

1. Configure the Channel Power Settings
The only configuration difference between ACPR and CP
measurements is the use of the “count” field. Changing the
count field will increase the number of channels that are
included in the channel power measurements.
Configure Spike for Channel Power Measurements
While Spike is displaying data from your test setup:
1. In Spike, in the Channel Power panel, set the following:
a.

Width = 200 kHz

Figure 12—The ACPR measures the amount of signal energy that has bled
into the adjacent channels, and can be used to predict interference.
This measurement requires a closed system test, as outside interference
could artificially inflate the power in the adjacent channels compared
to the primary channel.

b. Spacing = 200 kHz
c.

Count = 3

2. Select Enabled

2. Observe the Channel Power and
ACPR Measurements
Once the Enable field is selected, grey fields will appear designating
each channel being measured. A count of 3 measures the primary
channel and the two adjacent channels (see Figure 13). The Channel
Power and the ACPR are displayed in the center of each measured
channel. The ACPR measurement is displayed below the Channel
Power and is in the units of “dBc,” which are scalar logarithmic units.

Extended area

Figure 13—Changing the “Count” field in Spike to 4 or more extends the
adjacent channel power ratio measurement beyond the immediately
adjacent channels.

Further Reading
Download the Spike manual from www.signalhound.com/spike for more OBW and CPM information.

About Signal Hound
Signal Hound designs and builds powerful, affordable spectrum analyzers and signal generators for engineers and RF
professionals around the globe. Whether you’re needing EMC precompliance capabilities in a small two-person shop or
spectrum monitoring on a national scale, our test equipment is designed with you in mind. Accurate and powerful enough
for mission-critical RF analysis, priced at a point accessible to most, and supported by a talented group of engineers
committed to what they do – we truly believe that our devices offer unrivaled value in the test equipment industry.
In business since 1996 and selling our own line of Signal Hound test equipment since 2010, we’ve built the foundation
of our company on years of test equipment repair, service, hardware and software development, and manufacturing
experience. Signal Hound is a small company with big goals – and an even bigger commitment to providing our
customers with an outstanding experience when purchasing and using our products.
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